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1 OVERVIEW 
 
This guide is based on the Inter County Northern Bridge League (NBL) matches for Teams of 8. The program 
TeamsScorer is used and can be downloaded from  http://homepages.nildram.co.uk/~jasmith 
 
To use Bridgemate scoring, you need a consistent set of Bridgemate components. These may be downloaded 
from  http://www.bridgemate.com  The BCS program should usually be installed at C:\Program 
Files\Bridgemate Pro\Bmpro.exe. Latest versions:  
 
Bridgemate II:  BCS 2.6.1 Server 1.3.107d  Units 1.6.1 
Bridgemate Pro  BCS 2.6.1 Server 1.2.6  Units 2.3.2 
 
Team of 8 events are run as two session events by merging 2 matching team-of-4 sections into a team-of-8 for 
each session. Recommended movements for NBL are all available as System Movements. 
 
4 Teams: Two sessions of 3 x 7 board matches with immediate scoring.  Three sets of 28 boards should 

be prepared for each half.   
5 Teams: Two sessions of 4 x 5 board matches. Two sets of Boards 1-25 needed. American Whist 

Movements allow part match scoring with all teams at half-time. 
6 Teams: Sessions of 3 x 8 board and 2 x 8 board matches. Two sets of Boards 1-24 for each half. You 

can use a Howell movement allowing score every round. Alternatively, you can use a Stagger 
Movement allowing scoring with 3 teams at half-time. 

7 Teams: Sessions of 6 x 4 and 6 x 3 board rounds. Two sets of Boards 1-28 and 1-21 needed. 
American Whist movements allow part match scoring with all teams at half-time. 

8 Teams: Sessions of 4 x 6 and 3 x 6 board rounds. Two sets of Boards 1-24 boards for each half. Stagger 
movement allows scoring with 4 teams at half-time. 

9 Teams: Sessions of 8 x 3 and 8 x 2 board rounds. Two sets of Boards 1-27 and 1-18. 
American Whist movements allow part match scoring with all teams at half-time. 

 
The players start at their Home Table as Teams of 4 in both sections A and B. NS players stay in the same 
direction throughout. The EW pairs switch Sections for Session 2. 
 
For NBL scoring, all the result on a board are added together and the resulting value is converted to IMPs. The 
Total Imps against each Team-of-8 will be converted to VPs on the normal EBU Teams of 8 Scale. (Multiply the 
number of boards being played in each match by two, and use the standard Teams-of-four scale for that 
number eg for a 10-board Teams-of-eight competition scored this way, use a standard 20-board VP scale.) 
 
For the purposes of illustration in this document, we will assume 5 teams: 
 
Section A Bridgemates are numbered A1 to A5. 
Section B Bridgemates are numbered B1 to B5. 
 
To change the section letter or table number of a BMPro BridgeMate, use the TD-key at the beginning of the 
session whilst the BridgeMate screen shows BRIDGEMATE PRO V2.0a EN.  
 
Insert TD-key to adjust the section letter and / or  table number. 
Press +/- to adjust the group letter and click “OK”. 
Press Cancel to delete the table number, enter the new table number and click “OK”. 
Remove TD-key. (Leave the Channel as “0”) 
 
To setup a BMII Bridgemate, press OK to switch on the Bridgemate and then press the “Setup” function key. 
The middle two function keys will scroll down and up the menu items. To set a fixed table number, press the + 
key until the correct section (normally A) appears and then scroll down to the “Table” menu item and press the 
+ key to choose the table number. 
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2 MAIN MENU 
 
Start up the PC and Logon. Start TeamsScorer by double-clicking on the desktop icon or select it from the Start 
menu. It will open and the main menu will be displayed. 
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3 Player Database 
 
Click Player Database in the Main Menu 

 
 
Set the National Bridge Org = EBU. Select Player Management Tab.  
 

 
 
 
Click Set up latest EBU Member Lists button to download the latest EBU Database and make it available for 
BM2 Name Display when Player Numbers are entered. 
 
Click Return to take you back to the Main Menu. 
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4 EVENT HISTORY 

 
Click on TeamsScorer and the Event History screen is displayed 
 

 
 
Create 4 separate events with the supplied NBL movement: 
 
Session 1 Section A – 5 Tables, 4 x 5 board rounds 
Session 1 Section B – 5 Tables, 4 x 5 board rounds 
 
Session 2 Section A – 5 Tables, 4 x 5 board rounds 
Session 2 Section B – 5 Tables, 4 x 5 board rounds 
 
 
These will be combined into a Multi-Session Control event which is used to manage the whole event.   
 
The mechanism for doing this is explained in the next few pages. 



Running Team of 8 Matches with Bridgemates 

03/02/2012                                                                                                                                              Page 5 of 21 

 
5 Create New Event 
 
Click Create New Event on the Event History menu 

 
 
Enter Event Details:  Session 1, Section A (Red), Event Name NBL (+ Club Name, TD, Date etc) 
 
Select Scoring Tab 
 

 
 
Scoring Method is left as Team of 4 at this stage. It will be set to Teams of 8 in the combined MultiSession 
movement (see later).  
Tick ‘Convert Imps to VPs’ box, Set VP Scale=EBU, Leave Boards per Match ‘Calculated from Movement’ 
 
Click OK to take you back to the Event Menu 
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6 Event Menu 
 

 
 
Click Select Movement button on the above Event Menu screen. You will pass through this screen when going 
to different screens.
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7 Select Movement 
 
Click Select Movement on the Event Menu  
 

 
 
Select the number of Teams (=5) under Movements (bottom left) 
 
Then select the required movement (American Whist – 4 Matches 5 Boards) from the list that will then be 
displayed. The default is 4 x 5 board rounds.(For 4 x 6 board rounds, Change Number of Boards to 30.) 
 
You may check the movement using the Show Table Cards button. 
You may print Table Cards using the Print Table Cards button (not really needed for this movement). 
Click the OK  button and confirm the movement details when requested. 
This will take you back to the Event Menu.  
 
Click Exit Event on the Event Menu to return to the Event History screen. (Confim Y) 
 
 
In a similar way, set the movements for Section A and B in the other three events. For 5 teams, the movement 
in both Session is identical, but it may vary for other numbers of Teanms. In each event, leave the scoring as 
Teams of 4. This will be overridden later in the Multisession Control Event to Team-of-8 Aggregate.   
 
Event: Session 1 Section B (Blue)  
Event Name = NBL etc,  
Teams = 5, NBL Session 1 Movement  
 
Event: Session 2 Section A (Red)  
Event Name = NBL etc 
Teams = 5, NBL Session 2 Movement  
 
Event: Session 2 Section B (Blue)  
Event Name = NBL etc,  
Teams = 5, NBL Session 2 Movement  
 
 
Return to the Event History screen 
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8 Multisession Control Event 
 

 
 
To combine the Multisession Events, select (by click) the four events on the Event History screen. Click 
Combine Sessions button. Confirm ‘Yes’ and a message ‘Combined to Event 5’ appears. This Multisession 
Control Event can be used to control the Multi event throughout. 
(Alternatively, Session 1 Section events can be merged, and Session 2 Section events can be merged and run 
as separate events). 
 
Retrieve the MultiSession Control Event, click on Event Details and select Scoring Tab 
 

 
 
Set Scoring Method =“Team of 8: Aggregate all 4 scores together before converting to Imps (->VPs”) 
Ensure “Matches always assumed completed within a Session…” is unticked 
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9 LINKAGE 
 
 
Retrieve the Multisession Control Event and click Multisession Links on the Event Menu  
 

 
 
You can click the No Change in the Line Movement button to quckly set up the links. 
Red 1-5 MOVE TO Red 1-5 and similarly Blue 1-5 MOVE TO Blue 1-5 
 
 
Click Save Displayed Line Movement 
Click Return to Event Menu 
 
(If there were any names entered, Return to Event Menu will copy the names from Session 1 to Session 2) 
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10 NAMES 
 
The preferred method of Player Name Entry is via Bridgemates (see later). Alternatively, this can be done 
manually as follows.  
 
Click Player Names on Event Menu 

 
 
Ensure Enable Team Names is ticked, Disable Player ID Check is unticked and Max Players per Team = 8.  
Enter the Team Names into the first column. 
Numbers will be checked first as Player Ids, then as EBU numbers. It is preferable to use EBU Numbers for 
Player Names input. (See Player Database section) 
Enter the Team Name and the associated 8 Player squad in the order NS A, NS B, EW A, EW B pairs into 
Session 1 Section Red.  
 
Click OK 
 
The Player Names will automatically be copied from Section Red to Blue. 
If the Multi Links are set, they will also be copied to Session 2. 
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11 BRIDGEMATE SCORING 
 
Set out the Bridgemate scoring device and table number as required. When they are turned on, they will ask for 
confirmation of the section (A) and input of the table number (BM2s only). Please ask North’s to check the table 
number. Check that the BM server is on (USB / battery power light and battery status light on the controller 
should be illuminated). Click Bridge Unit Scorer to open the main Bridgemate control screen. 
 

 
 
Select BCS Options Tab to set the required Options for Teams Scoring 
 

 
 
You can click Restore EBU Teams Defaults to set the BCS options. Tick the Member Number (EBU 
Numbers) box to allow EBU number entry by the players, (or 0 if unknown) on the Bridgemates. Players 
should not Login to BMs until after the first round and play has started so leave the Entry at Home Table 
unticked. Set the Name Source to Player & NBO Database on the Extra Options for BM2 tab, to get 
immediate Name display on the Bridgemates after number entry. 
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11.1 Launch Bridgemate Control Software 
 
Ensure you set Session = 1 to do the Scoring for Session 1 only. 
 
Click Create Database (bottom left) to create the Bridgemate Control Database (.bws file) 
Ensure the “Reset Server” box is ticked, click Launch BCS and confirm if asked to do so.  
 

 
 
The Bridgemate Control Software Program (BCS) will be started and you should see the 10 Tables being 
added as clients to its Server.  Minimise the BCS Display. 
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11.2 Running the Session 
At this point, if you wish, you may select the BCS Setup Tab and click Reset Bridgemates button to ensure all 
Bridgemates are properly reset (BM2s only). 
 

 
 
Click on Start Receiving to begin receiving scores. Progress during the event can be monitored on the 
Bridgemate Scoring Results Tab. For the Red Section, Round 1, the display indicates that it is expecting 25 
scores.  Exp is the total scores expected from the Red Section tables in a particular round, Rx is the total 
scores received from the Red Section tables to date in that round. The number of scores received for individual 
tables is shown under the appropriate table column. Any score amendments or adjustments are best done on 
the BMs or in BCS.  
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11.3 Reading Names 
 

 
 
Players can enter their NBO number at the start. Any player without an NBO number can enter zero or blank. 
After the first round is well underway, check if all players have entered their number by clicking on the “Names” 
tab on the right hand side of the screen. If any names are missing, make a note of their table and position and 
get their name.  
 
At some point later, click Read Names from BCS button to read the player numbers from BCS. These are 
decoded into Names and stored in the Scorer. You can add further Names manually (or correct spelling) by 
returning to the Enter Names menu (or by using the Player Tab in BCS). 
 
Click Write Names to BCS button to send the corrected values back to BCS so they will appear correctly on 
the Bridgemate screens. Select the Results tab at the top of the Bridgemate Scoring screen to get back to the  
results monitor.  
 
 
 
11.4 Scrolling Results 
When you want to display scrolling results, select the Reports tab at the top of the Bridgemate Scoring screen. 
Select Scroll, Show Continuous Rank Display and click Ranks. The results should appear on the bridge 
room screen. You can click Travellers button to quickly check any results. 



Running Team of 8 Matches with Bridgemates 

03/02/2012                                                                                                                                              Page 15 of 21 

 
12 MANUAL SCORING 
 
This can be used if you need to update any scores manually in TeamsScorer. 
Click Enter Scores on the Event Menu to open the Travellers 

 

 
 
Using the drop-down boxes at the top of the screen, navigate to the appropriate Session, Section. Using the 
list-box, select the appropriate board. You can use the ‘N’ or ‘*’ key to quickly move to the Next Board or ‘P’ or 
‘/’ key to move to the Previous board. Command keys (e.g. N, P etc may be entered in Upper or Lower case) 
 
12.1 Entering or Replacing  a score 
Enter the score as 420, -90 or 420+, 90- etc in the Score column followed by Return and the score will be 
updated. There is an option to omit the final zero e.g.42+ or 9- etc.  Alternatively, select the Contract/Result 
option and enter the contract details in the score column. Full details of score entry are shown on the “Score 
Entry Guide” tab. 
 
12.2 Repeating a score 
Press the ‘R’ or ‘,’ key in the appropriate yellow Score box  
 
12.3 Deleting a score 
To delete a score – click in the appropriate yellow Score box in the Score column on the row corresponding to 
the NS & EW Pair numbers and press the ‘D’ key (case does not matter) – the score is deleted. 
 
12.4 Replacing a score with an Arbitral score  
Click in the appropriate box and enter the score as 50/50, 40/60, 60/00 etc. 
followed by <Enter> 
 
12.5 Split Score 
 
Using the Weighted Scores box enter the details of both scores. 
In the example (NS get 100% of NS+420, EW get 100% of NS+50) 
Then click box in the score column and press the ‘W’ key. Split scores may be 
shown by pressing the ‘S’ key.  
 
12.6 Fouled Boards 
 
Not applicable to Teams (In Pairs, use the F command to all scores which were played after the board was 
fouled. Those scores will be Matchpointed as a subfield.) 
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12.7 Pairs sit in Wrong Direction 
Not applicable to Teams. (The A command may be used to Arrow switch the particular pair’s score(s). 
Alternatively you may change the pair’s number by clicking on the pair number and following the instructions.)  
 
12.8 Other Adjustments 
 
Return to the Event Menu and click the Adjustments + Categories button 
 
Click on the Adjust Column corresponding to the pair, type in the value of the adjustment, and click OK to exit 
to Event screen. 

 
 
You may also set a Category (up to 4 characters) on this screen which will appear on the final Rankings and 
may be used as a filter on the final Rankings list.
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13 REPORTS 
 
At the end of the session when all scores are in, click Return to get to the Event Menu and click Display 
Reports. If Bridgemates are in use, close BCS via File > Close > File > Exit  
 

 
 
From Display Reports menu, you can publish the final rankings, match scores, scorecards etc. The most 
useful are Ranks & Match Scores for Teams of 8 results. To print Ranks with Masterpoints, Select Ranks in the 
Print Menu and Rank + Masterpoints in the Print Options. Click Display on Screen button to show ranks in 
Notepad File, Send to Printer button to print or Printer Preview button to check the layout (mainly page 
breaks). A wide range of reports are available in a variety of formats.  If you choose Notepad, CSV, XLS or 
Web Table/Text the report is displayed on screen in the selected format and a copy saved in the Reports 
folder in the PairsScorer installation folder. Text will be output to Notepad Text Editor.  
 
Another possibility is to backup the data file (PSEvents.dat) into the Backups Folder in the PairsScorer 
installation folder using the Make Backup of Scorer Data command on the Administration menu.   
 
Reports should be automatically aligned and paginated in Line Printer output. If you need to change print 
settings, select Printer Settings tab to open the Printer Settings screen where you can set the font, font size, 
orientation and for some reports the number of entries per page.  You can use the default Print Properties for 
A4 (Laser Printer) but the settings may have to be adjusted to obtain the best results with regard to the precise 
event details and printer. You can also specify which printer to use from those installed in your Printers Folder.   
 
Click Return to leave the Printer Settings screen.   
 
To leave the Display Reports screen,  
 
Click Return to Event Menu 
Click Return to Event History 



Running Team of 8 Matches with Bridgemates 

03/02/2012                                                                                                                                              Page 18 of 21 

 
14 Running Session 2 
 
 
The procedure is similar to Session 1 with the important difference that the Session 2 movement must be 
passed to BCS and Member Number input should be disabled. (Be careful here, otherwise you could overwrite 
the first Session results !) 
 
 
Thus after entering the Bridge Unit Scorer menu: 
 

Set Session = 2 before Create Database  etc   
 

Untick the Member Numbers in the BCS Options. The Player Names will have been set via the Links 
on the Multisession screen.   
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15 BUTLERS 
 
 
Click Adjust Seating in the Event Menu screen. 
 

 
 
Set up the Section Lineups for each match on the Adjust Seating screen. The quickest method is to set the 
Round 1 lineup for each County in each Session and then click Same Lineup To End of Session box. 
 
The Butler scores may be viewed by ticking the Butler checkbox on the Display Reports Screen. 
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16 County Teams of 8 League 
 
As an example, take a county teams event where a County plays matches against six other counties. 
The matches each have an "A", "B" and "C" Team, each of eight players. They consist of 32 boards, 8 against 
each pair in the opposition team. The "A", "B" and "C" matches are scored separately. The scores of all four 
pairs in a team are aggregated and the result converted to IMPs and, at the end of the match, to VPs on the 
EBU scale. In the first session, the "A" team plays boards 1-8 (2 boards per table, circulated round the four 
tables) and the "B" team plays boards 9-16. After 8 boards have been played, the teams meet up and score. 
The "A" team then play boards 9-16 and the "B" team plays boards 1-8. After those boards have been played, 
the teams meet up to score and have tea. The "C" team have an identical set of boards (pre-dealt on 
Duplimate) and they follow the "A" team "movement". In the second half of the match a similar procedure is 
followed for boards 17-32. The home team pairs move round the tables in turn; the way team retains the same 
seats throughout. For each match, the objective is  to enter the board scores for all 32 boards for all twelve 
pairs so as to generate the butlers (ignoring the highest and lowest scores) and save them in a format  can be 
e-mailed to the players.  

 
Admittedly, for 2 Teams of 8 Butlering not using Bridgemates, its a rather trivial use of the Scorer facilities and 
you may be better advised to do it manually or on a spreadsheet -  but the setup would be as follows.... 
Teams of 8 scoring is based on 2 Sections being combined together. Each Section is done as 1 Event. 
Assuming it is all done as one Session, and taking the A team as an example..... 
Table Cards are preset as: 
 
Table 1   Table 2 
1 v 2 1-8  2 v 1 1-8 
1 v 2 9-16  2 v 1 9-16 
1 v 2 17-24  2 v 1 17-24 
1 v 2 25-32  2 v 1 25-32 
 
where 1 is CountyX A Team and 2 is CountyY A Team. The fact that the Home A Teams moves is irrelevant to 
the Movement Card since it is still the same CountyX v ECounty at each Table throughout. The movement 
however will be reflected later by setting the 8 Player Names in the Names entry for the two Teams and then 
setting the Seating LineUp for each round which then allows the Butlering to be applied to the right pairs. 
 
So, the procedure is: 
 
Create Event (1) 
Event Details - Title 'CountyX v County Y A Teams', Section Red, Session 1,...Rest of info irrelevant 
Select Movement - Preset Movement (which is already in the list as a standard 2 Table movement but change 
boards to 32) 
OK, Exit 
 
Create Event (2) 
Event Details -Title County X v County Y 'A Teams', Section Blue,Session 1 ,...Rest of info irrelevant 
Select Movement - Preset Movement (which is already in the list as a standard 2 Table movement but change 
boards to 32) 
OK, Exit 
 
Merge Sections (by highlighting Events) 1,2 to Event (3) 
 
Retrieve Event 3 
Event Details - Set Scoring as Teams of 8 Agg to Imps (EBU Scale for 32 board matches), Butler Drops = 2. 
Set Players per Team=8 on Names Tab 
Names - Enter 8 Names for Section Red for each of 8 Teams (Team Name, then two lines of 4 Names 
preferably in NS,EW,NS,EW order) 
(The 8 Names will be auto copied to the Blue Section because it is a Multisection Team of 8) 
Set Seating Lineups for each of the 4 Rounds. You can save time with the Away Players using the 'Same 
remaining Session Lineup' button 
Enter Scores - These are scores on a particular Board so it is MANDATORY that the Players fill in a Board 
Traveller (as well as keep their individual scorecards if they like) 
....The Butler Ranks may be shown by ticking the Butler Ranks box on the Display Reports screen 
A similar procedure can be done for B & C using Events 4-6 and 7-9. Although B play Boards 9-16, followed by 
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Boards 1-8, if you are doing all this at the end of the match, then just use the same Table Cards - the fact that 
Round 2 was played before Round 1 and Round 4 was played before Round 3 is irrelevant. 
 
It isnt usual to do Butlers over different level matches....but.. to do an Overall Butler, you would need to put all 
three matches in the same section! 
 
You would have to set it as SIX Teams of 8 with CountyX B as Team 3, CountyY B as Team 4, CountyX as 
Team 5, CountyY as team 6. The Table 3,4 Cards would be set as: 
 
Table 3   Table 4 
3 v 4 1-8  4 v 3 1-8 
3 v 4 9-16  4 v 3 9-16 
3 v 4 17-24  4 v 3 17-24 
3 v 4 25-32  4 v 3 25-32 
 
and similarly Tables 5 & 6. 
... 
You can create this single section movement using the Movement Library facility  
You set this up as Section Red Movement., 
You set a similar movement as Section Blue Movement, 
Merge together 
Set Team of 8 Scoring, Names,Seating etc as before 
Now the Butlers will apply overall. 
 

 
 
 

END OF DOCUMENT 


